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Introduction

This document describes how to install, set up, and use FLEXIm, a flexible license manager
server from Flexera Software (previously Macrovision Corporation) that is used with
FORMS. FLEXIm manages your ReadSoft software licenses. The type of database or the
number of databases used in the system does not affect FLEXIm.

@ If you upgrade to FORMS 5-3 Service Pack 3 from any earlier version of FORMS,
reinstall FLEXIm using the version included with FORMS 5-3 SP3. (The FLEXIm version
number will change to 11.10.)

@ |Important: Anti-virus programs can interfere with normal operation of FLEXIm. You
may need to configure the anti-virus program to recognize FLEXIm as a “friendly”
program. The procedure depends on your anti-virus program and is outside the scope of
this document. However, it is known that you cannot run FLEXIm with Panda.

The five main components of FLEXIm are:

= The FLEXIm interface in which you both configure your license service and start and stop
the FLEXIm server (Imtools.exe)

= The license manager windows service (Imgrd.exe)

= The vendor windows service (enlm.exe)

= The license file (license.dat)
= A unique hardware dongle (if needed).

You receive the three EXE files automatically when you install FLEXIm; the license file and
hardware dongle come directly from ReadSoft.

This document applies to FORMS 5-3 Service Pack 3 and later. If you need information about
installing or configuring FLEXIm for use with and earlier version of FORMS, you need an
older version of this document. It is found on your original FORMS CD, or you can obtain it
from ReadSoft.
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Supported operating systems

=  Windows 7

=  Windows Vista

=  Windows Server 2008

*  Windows Server 2008 R2
= Windows Server 2003 SP1
=  Windows Server 2003 R2

=  Windows XP

Obtaining a license file and
hardware dongle from ReadSoft

ReadSoft provides a license file (Iicense.dat) that allows you to access the components of
your ReadSoft system. FLEXIm uses the license file to manage your different ReadSoft
licenses.

Most customers also receive a unique hardware dongle. In cases where you receive a soft
license or a license file with a time limit and without a dongle number, you do not need a
hardware dongle on the computer where FLEXIm is located.

Contact your local ReadSoft representative for details on how you can obtain the license file
and hardware dongle.
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Getting or updating a soft license

For systems where a hardware dongle cannot be used, it is possible to get volume-based
licensing using a soft license.

@ Note: It can take time to get the license validated. Therefore, begin the process of
obtaining a license before actually going to the site to install FORMS.

For an existing system, FLEXIm notifies you when you have used up 75%, 90%, and 95% of
the license capacity so that you can start this process before your license runs out.

To get a soft license

1. On the computer where the FLEXIm server is installed, open the \C:\flexIm folder and
double-click FieldExUti I .exe to open the SuperPro Field Exchange Utility dialog.

2. On the Software Key tab, click Get locking code.

3. Click E to save the text as a *. loc file.

4. Send the LOC file by email to orders@readsoft.com.

5. ReadSoft’s order department generates the license files (*. lic and license.dat) and
emails them back to you.

e Putthe *_licfilein afolder that is accessible from the computer where FLEXIm is
installed.

e Put one copy of the license .dat file in the location specified for GlobalPath in
the Ei local . ini file, and put another in Cz\FLEXIm.

6. Again on the computer where FLEXIm is installed, reopen the utility from step 1 above.

7. Use ﬂ in the lower part of the dialog to browse to the folder where you put the *_lic
license file. Select the file and click Open. The license code text is displayed in the box at
the bottom of the dialog.

8. Click Update license.
9. A dialog is displayed, telling you that the process was successful. Click OK.

10. Close the utility dialog using this button: sSs

The license is now ready to be used.
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To update an existing soft license

1. Notify orders@readsoft.com that your license needs to be updated.

2. The order department generates a new license.dat file with the same number as the
previous one and email it to you.

3. Replace your current file with the new one.

Before installation

The words “Change_This” are listed in the license.dat file as a temporary server name.
Open license.dat with Notepad, replace “Change_This” with the name of the server where
your FLEXIm software will be located, and save the change before you install FLEXIm.

Important

» The SERVER and VENDOR lines are the only ones that can be changed without
damaging the license file.

= Install FORMS before installing FLEXIm.

= If the license file you received has some numbers in the file name (for example
licensel2345_dat), delete the numbers. The file name must be license.dat.
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Installing a Sentinel driver

If you received a dongle from ReadSoft, then the dongle must use a Sentinel driver. Install the
driver separately, after you install FORMS. Which driver to install, as well as the procedure to
follow, depends on your operating system.

Windows XP
1. Connect the USB dongle.

2. When prompted for the driver, navigate to this file on the FORMS installation CD:
Tools & third party software\SentinelUSB\NT2000\1386\sntnlusb. inf.

When you are prompted to select a setup type, select Complete.

3. After the Sentinel driver is installed, ensure that the dongle is displayed in Device
Manager as a Software Security Token, Rainbow USB SuperPro, as shown here.

£, Device Manager

Fila  Action  View Help

WS @ A «=®a

- B NEWO-LAB2!
X
:
o
H
:

_5’ Computer
g Disk drives
i Display adapters
L, DYDJCD-ROM drives
[+ 4= Floppy disk cantrollers
+ i Floppy disk drives
+ =) IDE ATAJATAPT contrallsrs
[+ &g IEEE 1394 Bus host controllers
+| 2 Keyboards
+ 77y Mics and other painting devices
+ g Monitors
+ HE Network adapters
+ 5 Ports (COM &.LPT)
+ ¥ Processors
- % Software Security Token
i f& Rainbay LISE SuperPro
[+ @,/ Sound, video and game controllers
+ System devices
£ Universal Serial Bus controllers

If it is displayed as anything else, right-click the device and select Update driver. Then
browse again to the sntnlusb. inf file on your FORMS installation CD.
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All newer operating systems, and all 64-bit Windows
operating systems

@ Do not attach the dongle to the server until step 4.
1. Log on to Windows as an Administrator.
2. Onthe FORMS installation CD, navigate to Sentinel75.

3. Run the executable file (Sentinel Protection Installer 7.5.0.exe) and follow the
onscreen instructions.

When you are prompted to select a setup type, select Complete.

4. Attach the dongle to the server.

Problems?

If you have another operating system and experience difficulties with the version of the
Sentinel driver that is installed with FORMS, you can also try upgrading. Further information
about troubleshooting the Sentinel driver can be found in “Installing (or reinstalling) the
Sentinel driver” on page 30.
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Installing and setting up FLEXIm

Choosing a server

FLEXIm can be installed on any computer on the network that:

= Can be reached from the FORMS clients.

» Runs one of the required operating systems (see page 5).

= Has aspare LPT port or USB port for the dongle (normally).

= Can run constantly and does not need to be restarted during working hours.

For stand-alone installations, the server is most likely the computer where FORMS is
installed.

Installing FLEXIm

@ Note that as of May 3, 2013, there is a new release of FLEXIm that should be used with
FORMS. Do not install the original version that was included on the CD mentioned
below. Be sure to get FLEXIm server 11.10 revision 4 (or later) before installing.

1. Exit all Windows programs.
2. Insert the ReadSoft FORMS installation CD.

3. When the main menu appears, click Install Software. If the menu does not appear, run
autorun_.exe directly from the installation CD.

4. Click FLEXIm server.

5. When the first dialog appears, click Next.
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6. The Select program folder dialog appears. Click Next to accept the default folder.

InstallShield Wizard x|

Select program folder

Select a program folder.

Setup will add icons to the program folders listed below. “vYou may lwpe a new folder name or
zelect one from the exizting folders list. Click Mest to continue.

Program Falders:

Administrative Tools

[ rfartigm

Microzoft Office

Microzoft Office Tools

Microzoft SOL Server

Microsoft Wisual Studio ﬂ

< Back M et > | Cancel |

7. Click Next to install FLEXIm. The following components are installed in C:\FLEXIm on
your system:

e Imgrd.exe — the license manager daemon.

e Imtools.exe —a console program is used to configure, start and stop the license
server.

e ehlm.exe —the Vendor daemon.

e Imutil.exe —a utility program that assists you in checking in the license of a client
computer that has crashed.

e Installing FLEXIm for FORMS.pdf — this document.

e Installing FLEXIm for INVOICES.pdf — the corresponding document for
INVOICES.

8. The Setup complete dialog appears. Click Finish to complete the installation process.

9. If you are prompted to do so, restart the computer.
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Placing the license file in FORMS and FLEXIm

The FLEXIm server is now installed. The next step is to copy the license file (Iicense.dat)
obtained from ReadSoft to the global path folder specified for every client in the ReadSoft
system. This folder is specified as GlobalPath in each client’s Enlocal . ini file.

In most network installations, all FORMS clients share a common global path. In this case,
place license.dat in this one location. In other network installations, where the clients do
not share a common global path, make copies of license.dat and put them in all of the
different locations specified in the clients’ global path.

After the clients are set up, copy license.dat to C:\FLEXIm.

Attaching the hardware dongle

Attach your USB hardware dongle (if you received one from ReadSoft) to
the appropriate USB port of the computer where FLEXIm is located.

After you install the hardware dongle, the computer should detect it
automatically and match it with the Sentinel driver you installed (above). If it does not, reboot
the computer so the hardware dongle can be properly detected.

If you are prompted to locate the driver files manually, provide the appropriate path as
described on page 31.

Configuring and starting FLEXIm

Now it is time to set up the FLEXIm server to automatically manage your FORMS modules.

@ Note: If you started FLEXIm before connecting the dongle, then you must restart
FLEXIm.

1. Double-click Imtools.exe, located in C:\FLEXIm.

© Note: On the newer operating systems, you must run Imtools.exe as an
administrator. Even if you are an administrator on the server, you must right-click the
file and select Run as Administrator.
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2. Onthe Service/License File tab, select Configuration using Services.

LMTOOLS by Macrovision Corporation hitp:/fwww.globetrotter.com

File Edit Mode Help

Service/Licenze File | System Settings] LItiIities] Start.-‘Stu:upa’Hereadl Server Statuz | Server Diags | Config Sewic:es] Burruwing]

Services allow FLEXLM Servers ta run in the background

Server Lizt

" Configuration uzsing Licenze File

&+ Configuration uzing Services

3. Next, click the Config Services tab and ensure that the settings are as shown below. If
they are not, type the path information manually or click the Browse buttons and navigate
to the correct locations.

LMTOOLS by Macrovision Corporation http:/fwww.globetrotter.com

File Edit Mode Help

Service/Licensze Filel System Settings] LItiIities] Start.-’Sh:up.f’Heread] Server Status | Server Diags  Config Services l Eurmwing]

Configure Service

Service Mame |F|ea.;|5|:.ft ﬂ

Path tao the Imard. exe file |'::"‘FLE><‘I|'T""|""'5"d-EHE

Path to the license file |CAFLEXImlicense. dat

Sawve Service |

Remaove Service |

Browse

Browze

il

Fath to the debug log file |CAFLEXImdebug log Browse | View LDQ"'|

-

[ Use Services
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4. Select Use Services and click Save Service.

LMTOOLS by Macrovision Corporation hitp:/fwww.globetrotter.com

File Edit Mode Help

Service/License File] System Settings] LItiIitiesl Start.-’Stu:upf"Hereadl Server Status | Server Diags  Config Services lBDrruwing]

Configure Service
Save Service |

Service Mame FeadSaft =~
| J Femaove Service ‘

Browse

Browse
Fath to the Imgrd.exe file |E:\FLE><Im\Imgrd.e:-ce Q

Path to the license file |E:'\FLE><ImKIic:ense.dat

Path to the debuglog fle | C:AFLEXImidebug log Browse | i LDQ---‘

[w iStart Server at Power v Use Services

5. Select Start Server at Power Up to avoid having to restart the FLEXIm server manually
each time you reboot.

6. Click Save Service and then Yes in order to save this configuration.
7. The next step is to start FLEXIm. Click the Start/Stop/Reread tab.

8. Click Start Server. The settings you specified on the Config Services tab are now
available to FLEXIm.
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LMTOOLS by Macrovision Corporation http:/fwww.globetrotter.com
File Edit Mode Help

Service/Licensze File] Suztem Settings] Utiities  Start/Stop/Reread | Server Status | Server Diags | Config Services] Bu:urruwing]

Flexlm licensze Services installed on this computer

Start Server Stop Server ReRead Licenze File

[ Force Server Shutdown

AR JEE T AT MOTE: This bow musgt be checked to zhut down a licenze server

when licenzes are barrowed.

|Using Licenze File: C:AFLEXImicense dat

9. After the “Server Start Successful” message is displayed in the status bar (lower left
corner), select File > Exit to close the LMTOOLS dialog.

The FLEXIm server is now started. To ensure that it is running, use Windows Explorer to
look in the c:\FLEXIm folder, where you should see the ehIm file (with no extension). This
file is created after you click Start Server. Alternatively, use the Task Manager > Processes
tab to check that enIm.exe and Imgrd.exe are listed as running processes. You can also
check the log file, Debug. log.
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How the license request process
works internally

This is what happens when you start FORMS with the FLEXIm server running.
1. FORMS uses Ehlocal .ini to determine the global path defined for the system.

2. FORMS uses the global path to locate the license file (1icense.dat), which contains the
name of the server that hosts FLEXIm.

3. FORMS, the client, establishes a connection with the license manager daemon
(Imgrd.exe) on the FLEXIm server, using an appropriate port (27000 by default) and
determines which vendor daemon it needs to talk to — ehIm_exe in this case.

4. The license manager daemon determines which computer and port correspond to the
vendor daemon and sends that information back to the client.

5. The client establishes a connection with the specified vendor daemon and sends its request
for a license (that is, the client is requesting to open a FORMS module that it is licensed to
use).

6. The vendor daemon checks in its memory to see if any licenses are available and sends a
grant or denial back to the client.

7. If alicense for the FORMS module is available, the client can now run the module. If the
license request is denied, the module is not made available to the client.

See “Important notes about check-out order” on page 22 for examples of how this process
works.
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Shutting down the FLEXIm server

Voluntary termination

The license server is intended for constant use. However, if you need to shut it down for any
reason (such as if you want to move the FLEXIm software to a different server), do the
following:

1. Open the FLEXIm dialog again by double-clicking Imtools.exe in C:\FLEXIm.

2. Select Configure using services on the Service/License File tab again, and the click the
Start/Stop/Reread tab.

3. Click Stop Server.

LMTOOLS by Macrovision Corporation http:/fwww.globetrotter.com
File Edit Mode Help

Service/Licensze File] Suztem Settings] Utiities  Start/Stop/Reread | Server Status | Server Diags | Config Services] Bu:urruwing]

Fleslm license Services installed on this computer

Start Server m ReRead Licenze File
[~ Force Server Shutdawn

MOTE: Thizs box must be checked to shut down a licenze server
when licenzes are barrowed.

Advanced settings >

|L|$ing Licensze File: C:AFLEXImicense. dat

4. When you are ready to start the server again, simply click Start Server on this same tab.
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Abnormal termination

If the server has crashed or has been terminated abnormally, follow these instructions:

1.

Click the Task Manager’s Processes tab to see if the enlm.exe and Imgrd.exe processes
are running. If they are running, end these tasks.

In the Cc:\FLEXIm folder, check for a file named EhIm (without an extension). If you find
this file, delete it.

Restart FLEXIm by clicking Start Server on the Start/Stop/Reread tab. Use the Task
Manager (or Windows Explorer) as described on page 15 to make sure the server is
running again.

Client crashes

If a client crashes, its license might not be checked in properly. The usual way to resolve this
is to restart the FLEXIm service. However, you can also use the “Imutils” program to check in
the license of a client that has crashed. Use this procedure:

1.

Start a command prompt session on the FLEXIm server and move to the C:\FLEXIm
folder.

Run Imutil Imstat —a to list all the licenses and the users that are connected to them. (Type
C:\FLEXIm>Imutil Imstat —a on the command line.)

Note the license feature, the user name, and the computer name of the client that crashed.

Run Imutil Imremove <feature> <"user”> <host> <display> to remove the unused feature
(<display> is the same as <host>). Here is an example:

C:\FLEXIm>Imutil Imremove EFVERI “Joe Smith” joes joes

This removes the FORMS Verify module license that the user “Joe Smith” has checked
out on the computer named “joes”.
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The license file

ReadSoft sets up any license.dat file in one of these ways:

With a dongle number

With a time limit

With a time limit and a dongle number
With a volume limit and a dongle number

With a time limit, a volume limit, and a dongle number

Examples of all four are found below, as well as an explanation of the order in which licenses
(for FORMS modules) are checked out.

For your convenience, warning messages are displayed in FORMS when your license is about
to expire or be used up. You can also check the About FORMS or System info dialog to
check the status (see “Checking when your license expires or is used up” on page 24).
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License file with a dongle number

The image below shows a license.dat file with a dongle number. The FEATURE lines
represent separate licenses (that is, FORMS modules) that were purchased. An explanation of
the fields in the license file is listed below the fields.

I license.dat - Notepad Q@g

File Edit Format Wiew Help

W DO WOT EDIT THIS FILE EXCEPT FOR THE SERWER WAME (IF WEEDED)

# ____________________________________________________________

SERVER  Change_This RS_Dongle=12345

WENDOR EHLM

FEATURE EFFULL EHLM 1,000 permanent 1 SEFADSS12D50 DUP_SEOUP=UHD
FEATURE EFFROF EHLM 1,000 permanemnt 1 FB5BBRE3306A DUP_GRCUP=UHL
FEATURE EFMNGE EHLM 1,000 permanent 1 FoAd4a9416B62

FEATURE EFSCAN EHLM 1.000 permanent 2 CAEFDZ25B5CAC

FEATURE EFITEP EHLM 1,000 permanent 2 ADESDE25 8188

FEATURE EFVERI EHLM 1,000 permanemnt 10 4aC8903673969

FEATURE EFTRAN EHLM 1,000 permanent 1 7457C0464F a3

FEATURE A150 EHLM 1,000 permanent 2 ALEEADTIBEEAF

FEATURE EMATL_16&00K EHLM 1,000 permanent 1 SEODE42EE44D

FEATURE EMAIL_DOCCAP EHLM 1,000 permanent 100 ASEABIACEI GG

FEATURE EHZForms EHLM 1.000 permanent 1 12118373EGEDA

FEATURE EHsClient EHLM 1.000 permanent i7 261EBB2C3 280

# The different fields in the license file, abowe, is described below!

# ________________________________________________________________________

# Your Dongle number 1s 12345

# Your server nawe 1s Change_This

# vou need to replace the text 'Change_This' with the server name where FLEXIm 1s installed

# “ou hawve a total of 1 { 1 (EFPROF) + O (EFSTD) + O (EFLITE) + O (EFENTRY) 2 FULL FORMS licenses
# vou have 1 (where one Ticense can be used by 5 FULL modules) FULL licenses with 'PROFESSIONAL' process speed
# vou hawve 1 Manager (EFMHGR) licenses

# You have 2 Scan (EFSCAN) Ticenses

# You have a total of 2 {0 (ASTD) + O {AF5) + 2 (15900 + O {A300) ) Interpret (EFITRP) licenses
# vou hawve 10 Verify (EFWERI) licenses

# vou have 1 Transfer (EFTRAN) licenses

# You have 2 Interpret (EFITEP) licenses with Itrp speed A150

# Below follows INVOICES licenses ———————————————————————m—m

# Below follows eMail Option Pack licenses ——-———-—mmmmmmmmm e

# vou hawve 1 eMail Option Pack (EMAIL) licenses with 1600K document capacity

# vou have a document capacity of 1600 thousand documents per year

# Below follows Monitor Option Pack Ticenses -——-——-—————- e

# wou hawve 1 FOEMS Monitor licenses

# vou hawe 17 Monitor client licenses

@ Warning: The SERVER and VENDOR lines are the only ones that can be changed
without damaging the license file.

The words “Change_This” are listed in the license.dat file as a temporary server name.
Replace “Change_This” with the name of the server where the FLEXIm software is (or will
be) located. For a stand-alone computer with no name comparable to a server name, use
this_host. Save this change before placing license.dat in the locations specified in
“Configuring and starting FLEXIm” on page 12.
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License file with a time limit

Instead of using a hardware dongle number, you might use a license file that has a time limit.
In the following example from a FORMS license file, the limit is November 26, 2012. The
field that usually contains the hardware dongle number contains the text, “ANY™.

SERVER testserver ANY

VENDOR EHLM

FEATURE EFFULL EHLM 1.000 26-Nov-2012 7 AAAAAAAAAA DUP_GROUP=UHD

License file with a time limit and a dongle
number

You might use a license file that has a time limit and a hardware dongle number. In the
following example from a FORMS license file, the limit is November 26, 2012 and the

hardware dongle number is 23123.
SERVER testserver RS _Dongle=23123

VENDOR EHLM

FEATURE EFFULL EHLM 1.000 26-Nov-2012 7 AAAAAAAAAA DUP_GROUP=UHD

License file with a volume limit and a
dongle number

With FORMS 5-3 Service Pack 2 and later, you can use a license file that has a volume limit
and a hardware dongle number. In the following example from a FORMS license file, the
volume limit is 10,000 pages (which you can see by the “10” in the third line). The hardware

dongle number is 23123.
SERVER testserver RS_Dongle=23123

VENDOR EHLM

FEATURE FORMS_DOCCAP EHLM 1.000 permanent 10 AAAAAAAAAA
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License file with a time limit, a volume
limit, and a dongle number

With FORMS 5-3 Service Pack 2 and later, you can use a license file that has a time limit, a
volume limit, and a hardware dongle number. In the following example from a FORMS
license file, the volume limit is 10,000 pages (which you can see by the “10” in the third line).
The dongle number is 23123, and the license expires on November 26, 2012.

SERVER testserver RS_Dongle=23123
VENDOR EHLM
FEATURE EFFULL EHLM 1.000 26-Nov-2012 1 AAAAAAAAAA DUP_GROUP=UHD

FEATURE FORMS_DOCCAP EHLM 1.000 26-Nov-2012 10  AAAAAAAAAA

Important notes about check-out order

The client with a full FORMS installation

When any module is opened on a client with a full installation®, the program first tries to open
a FULL license (that is, EFFULL). If it succeeds, then it makes sure that the client receives the
EFFULL license, plus the license with the highest-performing interpreter, if this is available (in
other words, a FORMS Professional version, EFPROF). In such a case, both EFFULL and
EFPROF are checked out. If no EFPROF license is available, then the client receives an EFSTD
license, if this is available.

If no EFFULL license is available, the program tries to open a separate license that might exist
for that particular module (for example, FEATURE EFITRP if Interpret is being opened). If it
succeeds in opening an individual EFITRP license, it again looks for the license with the
highest performing interpreter, if this license is available.

! That is, when License=FULL is found in the [Settings] section of the Enlocal . ini file.

Installing and Configuring FLEXIm for Use With FORMS (5-3 SP3 and later) | © ReadSoft | page 22 of 34



As an example, consider the following lines from the Debug. log file:

11:10:06 (EHLM) OUT: “EFFULL” Lars Gustafsson@Ilarsg
11:10:06 (EHLM) OUT: “EFPROF” Lars Gustafsson@larsg

11:37:03 (EHLM) DENIED: “EFFULL"” Anders Svensson@test2000p (Licensed number of users
already reached (-4,342))

11:37:04 (EHLM) OUT: “EFMNGR” Anders Svensson@test2000p
12:18:02 (EHLM) IN: “EFMNGR” Anders Svensson@test2000p

The users, Lars and Anders, each have License=FULL in their Enlocal . ini files. When Lars
opens a FORMS Manager module from his workstation, FLEXIm checks out the only
available EFFULL license (which, in this case, is a Professional full license). When Anders
tries to open a Manager module from his workstation, there is no EFFULL available on the
network.

In this case, the program checks if there is a separate Manager module available (EFMNGR).
In this particular instance, an EFMNGR license is available, so this is the one that opens on
Anders’ computer.

As you can see in the final line of the log file, Anders closes the Manager module after about
40 minutes. FLEXIm interprets this as “checking in” the EFMNGR license, which is now
available to other authorized users in the network.

The client with individual modules installed

When any module is opened on a client with only individual modules installed?, the program
first tries to open a license for that module. If it succeeds, then the module runs. Again, if the
module being opened is Interpret, then the client receives the highest performing Interpret
module that is available.

If no individual license is available, the program tries to open an EFFULL license. If it
succeeds, all of the FORMS modules associated with that one EFFULL license are locked (and
an EFPROF license is given first, if available).

Consequences

If you purchased an individual license for a higher performing interpreter (such as A150) and
are using FLEXIm, you must run Interpret on a client that only has individual modules on it,
and not a full installation. Otherwise, the program first tries to open an EFFULL license, and
you do not get to use the A150 license if an EFFULL license is available.

% That is, when License=MODULE is found in the [Settings] section of the Enlocal . ini file.
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When you check out an EFFULL license, the interpreter is always the one from the highest
performing EFFULL license available (for example, EFPROF).

Checking when your license expires or is
used up

FORMS licensing is normally based on either the number of pages processed or time. After
the volume limit or the expiry date is reached, the license must be renewed to continue using
FORMS.

For your convenience, warning messages are displayed in FORMS when 70%, 80%, 90%,
and 95% of a licensed volume is used up. For a time-limited license, warning messages are
displayed each time you log in, starting 30 days before the license expires.

You can also check the About FORMS or System info dialog to check the status:
5. Open a FORMS module.

6. Select Help > About FORMS > System info.

About ReadSoft FORMS ot
ReadSoft FORMS Interpret
Wersion: 5-35P 2 - Standard
Build no.: 10150
Walid until: Mo expiry date [FLM 5]
Pages per pear: R000 [1000 uzed]
® ReadSoft AB System info 5o
| . ReadSoft FORMS Interpret
Ertensions... |
Wersioh: 5-3 5P 2 - Standard
([ susemine. | ) Build ne.: 10150
Walid until: Mo expiry date [FLM/S)
Pagesz per year: R000 [1000 uzed]
Database: Alba@STH-ST [SAL Server]
Sanner
Scanner Canon DR 3020
Scanner card: SC5I
Computer
Operating spster:  Windows 7 wersion 6.1 [build no. 7600) , 64-bit.
Processor AMD B4 platform (64-bit processor] (4 processors).
temary: 8248620 KB = 8055 ME
Free dizk space: C: 403381068 KB = 354512 MB
Screen resolution:  1600x1200
Print & sawve. . | [ Ok
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Volume-based license

If you have a volume-based license, both the About dialog and the System info dialog in
FORMS tell you the capacity of your current license—in pages per year—and how much of
that capacity has been used.

How are forms counted?

Forms are counted in the Scan module or (when forms are imported) in the Interpret module.
Each page of a multi-page form is counted. A two-sided form counts as two pages.

License with a time limit

If you have a time-limited license, both the About dialog and the System info dialog in
FORMS tell you (on the Valid until line) when the license will expire. This date matches the
expiration date in the license file that you received from ReadSoft (described on page 19).

The type of license is also displayed
The type of license is displayed on the Valid until line:
D = Dongle
ND = No-dongle file
FLM/S = FLEXIm Server license

FLM/L = FLEXIm Local file
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Troubleshooting

Troubleshooting checklist

The information above describes how FLEXIm is supposed to work. If you have any
problems with FLEXIm, then go through the following checklist to find the problem and
correct it.

= |f you see this error message when you start a FORMS module:

The current FLEXIm server does not support this version of FORMS. Please upgrade
the license server.

This message is displayed if you upgrade to FORMS 5-3 Service Pack 3 from any earlier
version of FORMS without also upgrading FLEXIm. Reinstall FLEXIm using the version
included with FORMS 5-3 SP3. (The FLEXIm version number will change to 11.10.)

= Alternatively, if you are using a USB dongle, ensure that it is properly connected to the
USB port of the computer where FLEXIm is running.

If you followed the instructions in this document, the driver was installed before the USB
dongle was connected. If you mistakenly connect the dongle first, the operating system
uses the first driver it finds — not necessarily the one that is supposed to be used. If this
happens and it causes problems, you must remove the dongle, uninstall the Sentinel
driver, and reinstall it (as described on page 30).

= Ensure that the correct server name is listed in the license file (the name after SERVER on
the first line). When you received the file, the words “Change_This” were listed as a
temporary server name. Ensure that it has been changed as described on page 7 and that
the file name is license.dat.

= When the FLEXIm server is running, ensure that enm (a file with no extension) is located
in the C:\FLEXIm folder.

= Ensure that no ReadSoft clients have a C:\FLEXIm folder that is not being used as a
license server.

= Ensure that all ReadSoft clients can connect to the global path (defined in their
Ehlocal . ini files) and have access to the license.dat file.

= Whenever the FLEXIm server is about to be started (that is, just before you click Start
Server), ehlm (a file with no extension) should not be located in the C:\FLEX1Im folder.
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= Ensure that the license manager service (Imgrd.exe, called “ReadSoft” in the dialog) has
the status Started and is set to Automatic on the computer where FLEXIm is running.

Sesvice/Licenze File] Syshem Setl'ngsl Utilties ~ Start/Stop/Reread | Server Gtatus | Server Diags | Config Sevices | Bnuawing]

aEa)

Flesdrn Bcense Services installed on this computes

Start Server | Stop Sesver FAeRead Licenze File

. [ Force Server Shutdown
Sttt L MOTE: This bos must ba checked to shut dovwn & license sanver

when icenses are bomowed,

" Services

[Us'ﬂg License File: CAFLEXImbicense. dat

Fi=  Acbon  Yiew

M BB 2 mElm

iy Services (Local)

Help

*u Services (Local) |

ReadSoft Mame | Descripbion | Skatus | Starbup Type | Log On As | ~
) %F’roteded Storage Provides pr.,, Started Ak omatic Local System
Stap the service 8005 RSVP Provides n... tanual Local System

Pause the service

Restart the carvics i Readsoft Started Aukomatic Local System
%Remte fccess Ak, Createsa .., tManual Local System
%Remte Access Con,.. Createsa ... Started Marysal Local System
%Remte Deshktop He,.. Manages a... Marisal Local System
%Remte Procedure ... Providesth.,, Started Bk omatic Local System
Sy Remote Procedure .. Managest.. Started Marisal Metwork, 5.
%Remﬂte Registry Enablesre.., Started Bk omatic Local Service
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When the FLEXIm server is started and running, ensure that these lines can be seen at the
beginning of the Debug. log file. (You specified the path to this file in step 3 on page 13.)

- I Debug. log - Notepad g@@

File Edit Format Wiew Help

11:03:13 {Imgrd) ————— e -
11:03:13 (Imgrd) Please Note:

11:03:13 {Imgrd)

11:03:13 (Imgrd) This log 1s intended for debug purposes only.

11:03:13 {Imgrd) There are many details in licensing policies

11:03:13 {Imgrd) that are not reported in the information logged

11:03:13 {Imgrd) here, so it you use this Tog file for any kind

11:03:13 (Imgrd) of usage reporting you will generally produce

11:03:13 (Imgrd) incorrect results.

11:03:13 (Imgrd)

11:03:13 {Imgrd) - ————— -
11:03:13 {Imgrd)

11:03:13 (Imgrd)

11:03:13 (Imgrd) Detecting other Imgrd processes...

11:03:13 (Imgrd) Done rereading

11:03:13 (Imgrd) FLExIm {w3.4a) started on sth-pontus {IEBM PC) ({11,/10,/2005)
11:03:13 {Imgrd) Copyright (c) 1988-2003 by Macrowision Corporation. 811 rights reserved.
11:03:13 {Imgrd) US Patents 5,320,297 and 5,671,412

11:03:13 {Imgrd) wWorld Wide Web: http:/ S, macrowi sion. com

11:03:13 (Imgrd) License file(s): C:NFLE<XIm4license.dat

11:03:13 {Imgrd) Imgrd tcp-port 27000

11:03:13 (Imgrd) Starting wendor daemons ...

11:03:13 (Imgrd) Started EHLM (pid 440)

11:03:13 (EHLM) Serwer started on sth-pontus for: EFFULL
11:03:13 (EHLM) EFFROF EFMNGE EFSCAN
11:03:13 ({EHLM) EFITREP EFVERI EFTREAN
11:03:13 (EHLM) ASTD A150 A300
11:03:13 (EHLM) EHAVERI EHAITEF

11:03:13 (Imgrd) EHLM using TCP-port 1045

If there is a message like “Invalid hostID on SERVER line”, and you have already
checked the points listed above, reinstall the Sentinel driver as described on page 30.

Ensure that there is nothing wrong with the port that the dongle is connected to. Try
connecting a peripheral device to the port to see if it works.

If the port that the dongle is connected to is not damaged, then you may need a new
hardware dongle from your local ReadSoft representative.
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= Ensure that no anti-virus program is interfering with normal operation of FLEXIm. For
example, an error message similar to this one can indicate a problem with anti-virus
software:

12:11:10 (Imgrd) Started EHLM (pid 5632)

12:11:10 (EHLM) Server started on pavranb for: EFFULL
12:11:10 (EHLM) Vendor daemon can't talk to Imgrd ()
12:11:25 (Imgrd) Vendor daemon died with status 28
12:11:25 (Imgrd) Since this is an unknown status, Imgrd will
12:11:25 (Imgrd) attempt to re-start the vendor daemon.
12:11:25 (Imgrd) Restarted EHLM (pid 5188)

12:11:25 (EHLM) Vendor daemon can't talk to Imgrd ()

You may need to configure the anti-virus program to recognize FLEXIm as a “friendly”
program, or disable functions intended to prevent a TCP/IP attack. The procedure depends
on your anti-virus program and is outside the scope of this document. However, it is
known that you cannot run FLEXIm with Panda.

Windows firewall is causing problems

Depending on what a computer is used for, different ports need to be opened. The list below
shows the default ports to open for FLEXIm. If default ports are not used, then you must open
the ones that are used.

23 FLEXIm server. This port is used to communicate with FLEXIm using
Telnet, as the LMTOOLS and LMSTAT tools do.

744 FLEXIm server. Used to communicate with FLEXIm .
1090 EHLM.EXE ReadSoft FLEXIm agent.
27000 LMGRD.EXE FLEXIm server daemon.

In the case of FLEXIm, you must also edit your license.dat file, specifying the TCP/IP port
number that the daemon uses. Below is an example of how to change the SERVER and
VENDOR lines in license.dat to specify ports 27000 and 1090. The example is from a
FORMS license file with a dongle number.
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Before:

SERVER Change This RS_Dongle=23123
VENDOR EHLM

After:
SERVER Change_This RS_Dongle=23123 27000
VENDOR EHLM port=1090

If problems persist

You may encounter other types of errors that are not presented in this document. If problems
persist after following the guidelines above, please also check:

= FLEXIm™ End Users Guide, provided by Flexera Software (previously Macrovision
Corporation) and included in your installation. The file name is enduser . pdf.

» Frequently Asked Questions concerning FLEXIm a ReadSoft document that is included in
your installation. The file name is FLEXIm_FAQ. pdf.

You may also contact your ReadSoft Support representative. Information on how to reach the
local support channels is available at http://www.readsoft.com/services/support.htm.

Installing (or reinstalling) the Sentinel
driver

If you received a USB dongle from ReadSoft, then the dongle must use a Sentinel driver. This
driver is installed during FORMS installation.

Here are some lines from Debug. log that point to a problem that could be caused by using the
wrong USB driver:

19:31:20 (EHLM) Wrong hostid on SERVER line for license file:

19:31:20 (EHLM) C:\FLEXIm\license.dat

19:31:20 (EHLM) SERVER line says RS_Dongle=1234, hostid is (Can’t get hostid of type 1001 [])
19:31:20 (EHLM) Invalid hostid on SERVER line

Another sign of using the wrong driver is if you see this error message when you try to start
FORMS: “The connected hardware lock is not valid for this module...”
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If you have one of these problems, try rebooting. If that does not work, follow this procedure
to reinstall the Sentinel driver:

1. Open the Control Panel and choose Add or Remove Programs.
2. Select Sentinel System Driver and uninstall it.

3. Use the Device Manager to uninstall the USB controller.

4. Physically remove the USB dongle.

5. Stop the FLEXIm service.

6. Reboot the PC.

7. This step depends on your operating system:

Windows 2000, Windows NT 4.0, and Windows XP
a) After login, connect the USB dongle.

b) When prompted for the driver, navigate to \Sentine lUSB\NT2000\ 1386\
sntnlusb.inf.

The Sentinel driver is now correctly installed.

c) Ensure that the USB dongle is
displayed in Device Manager as a _ _
Software Security Token, Rainbow | File Action  View Help

£, Device Manager

USB SuperPro, as shown here. W EyES @ =X a
. : -2 NEWO-LABZI
d) Ifitisdisplayed as anything else, + ) Computer

right-click the device and select
Update driver. Then navigate : :
again to \Sentine lUSB\NT2000\ & DYO/CO-ROM drives

_ =) Floppy disk controllars
1386\sntnlusb. inf. + I3 Floppy disk drives

+ =) IDE ATAJATAPT controllers
[+ & IEEE 1394 Bus host contrallers
+ o Keyboards
+ 77y Mice and other pointing devices
[+ é Monitors
+ H8 Metwork adapters
5 Ports (COM & LPT)
[+ ﬁ Processors
- €2 Software Security Token
-4 ainbovy USE SuperFrol

E3 @,/ Sound, wideo and game controllers

+ v System devices
¥ Universal Serial Bus conkrallers

g Disk. drives
) Display adapters

[
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All newer operating systems, and all 64-bit Windows operating systems
a)
b)

d)

Log on to Windows as an Administrator.

Click Install Software > Third-party software. Windows Explorer opens and
displays the third-party software available on the CD. In the Sentinel 75 folder,
double-click the executable file, Sentinel Protection Installer
7.5.0.exe.

Alternatively, download the latest Sentinel driver from http://www.safenet-inc.com
and install it.

Open the Device Manager and confirm that the Sentinel75 driver appears in the Non-
Plug and Play Drivers. (If you cannot see Non-Plug and Play Drivers, select View
> Show hidden devices. If it is still not visible, restart the PC.)

Connect the USB dongle, verify that it is found by the operating system, and verify
that the USB driver is correctly installed.

A Computer Management

File Action View Help

e«=|2E B HE &

& Computer Management (Local| | =g STH-QATEST4E

Fi '[[’} Systemn Tools +|- Computer
: @ Task Scheduler +1,_..,| Disk drives
s Event Viewer +|',-, Display adapters
-z Shared Folders +1,__..,| DVD/CD-ROM drives

- i Local Users and Groups +- == Floppy disk drives
, '@I Reliability and Performe +x:E Fleppy drive controllers

7% Device Manager ';'"{_ﬂ' IDE ATA/ATAPI controllers
a4 =3 Storage + @ IEEE 1394 Bus host controllers
= Disk Management +_ Keyboards
T Services and Applications +ﬂ Mice and cther pointing devices
+I.. Menitors

+I-_7Il‘ Metwork adapters

] or-piug ond iy Drve

+‘? Ports (COM & LPT)

+D Processors

+J\ Sound, video and game controllers
;.---{;,‘— Storage controllers

+l_-u Storage Velumes

+-ihal System devices

3 ¥ Universal Serial Bus controllers
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8. If you are using Windows 2000, Windows NT 4.0 or Windows XP, run
\SentinelUSB\NT2000\SetupX86.exe t0 ensure that the driver is set up correctly:

sle  Action  Miew  Help

[ FE 2 8

1 =) NEWO-LAB2L
'§ Computer
[#]-=g@ Disk drives

¥
1+ »ﬁ Display adapters
+ .}, DYDJCD-ROM drives

d = .
] @ Floppy disk conkrallers Sentinel Driver, @

=+ \_g Floppy disk drives

Ports
+ () IDE ATAJATAPI controllers
[+ &g IEEE 1394 Bus host contrallers Phusical Addr Dos Created
e Keyboards Address  Port Type Bus #t Bus Type Space Addr  Use? By
417 Mice and other pointing device
-5 Monitors use —  UsB Yes System

4+ !ﬂ Metwork adapters

+ % Ports (COM & LPT)

+ %98 Processors

=l 9&0 Software Security Token
€& Rainbow LISE SuperPro

%), Sound, video and game control Add Edit | m Cancel Help About

- System devices
* Universal Serial Bus controllers

@Back > )

Address | (£ C:\Forms _ : T T

i | B sebupx86
File and Folder Tasks Al | | 1566 r Sentinel Driver Setup DLL

@ Rainbow Technologies, Inc.
=]} Rename this fil

[y Move this File %b' srtalpha.di ‘»&r shti3ss.dil
1 0.5,0,39 2 0,5.0.39
D Copy this file 3 Sentinel Driver Setup DLL : Sentinel Driver Setup DLL

&) Publish this file to the Web
N O Emaithis fie
|! | ¥ Delete this file

Sy

Br sntppc, dll
.| 050,

| Sentinel Driver Setup DLL

(There is no way to perform this procedure on the newer operating systems, or on any 64-
bit operating system.)

9. Check the Control Panel (Add or Remove Programs) and ensure that the driver is
installed as a program.

If USB driver problems persist, download the latest driver from http://www.safenet-
inc.com/ and install it. (Diagnostic software is also available on that website.)

10. Start the FLEXIm service. (See page 14 for instructions.)

11. Check the Debug. log file and ensure that “Invalid hostID on SERVER line” does not
appear. If it does, reboot the computer and check Debug. 1og again.
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Verifying the presence of the Sentinel
Security Runtime

1. Select Start > Settings > Control Panel > Administrative Tools.
2. Double-click Services. The Services dialog is displayed.

3. Locate the Sentinel Security Runtime service. If the service is running, the status of
Sentinel Security Runtime service is Started.

Verifying the presence of the Sentinel
Protection Server

1. Select Start > Settings > Control Panel > Administrative Tools.

2. Double-click Services. The Services dialog is displayed.

3. Locate the Sentinel Protection Server. If the server is running, the status is Started.

Verifying the presence of the Sentinel Keys

1. Select Start > Settings > Control Panel > Administrative Tools.
2. Double-click Services. The Services dialog is displayed.

3. Locate the Sentinel Keys Server. If the server is running, the status is Started.
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